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Software License Agreement 

By accepting this software license agreement (Agreement) and downloading this 
software, the parties agree that a software license agreement is entered into by and 
between the user (“LICENSEE”) and Windward Environmental LLC 
(“WINDWARD”), and that the parties hereby agree to be bound by the following 
terms and conditions. Any subsequent LICENSEES shall be similarly bound. If 
LICENSEE does not wish to agree to these terms and conditions, then use of this 
software is prohibited. 

LICENSE FOR USE 

By this Agreement, LICENSEE is licensed to use this program as LICENSEE sees fit, 
including modifying this program, except that LICENSEE agrees not to sell or transfer 
this program to anyone without the express written consent of WINDWARD. 

TERM 

The license to use this software is effective until terminated. LICENSEE may terminate 
this license by destroying the program and all its copies and removing any and all 
software and information generated therefrom from all of LICENSEE’S computers. 
This license may also terminate, at WINDWARD's discretion, if LICENSEE breaches 
the terms of this Agreement. 

LIMITED WARRANTY/LIMITATION OF LIABILITY 

This software is provided “as is” without warranty of any kind, either express or 
implied, including, but not limited to, the implied warranties of merchantability and 
fitness for a particular use. In no event shall WINDWARD be liable for any damages, 
lost profits, lost savings, or other incidental or consequential damages of any kind 
arising from the use of or inability to use the software, notwithstanding any 
statements or representations made to the contrary or WINDWARD being notified of 
the possibility of damages.  

GENERAL 

If any provision of this Agreement is found to be unenforceable, void, or unlawful, 
then that provision shall be deemed severed and shall not affect the enforceability of 
the remaining portions of this Agreement. This Agreement is governed by the laws of 
the State of Washington.  

LICENSEE may not transfer, assign, or sublicense this program or license except as 
expressly provided in this Agreement. 
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This limited warranty gives LICENSEE specific legal rights. Some states provide other 
rights, and some states do not allow the exclusion of implied warranties or limited 
liability for incidental or consequential damages. As a result, the above limitations 
may not apply in their entirely to LICENSEE. Nonetheless, this Agreement applies to 
LICENSEE to the fullest extent allowed by applicable law. 

ACKNOWLEDGEMENT 

By downloading the software and accepting this Software License Agreement, 
LICENSEE hereby accepts all the terms and conditions of this Agreement without 
exception, deletion, or alteration. This Agreement constitutes the entire agreement 
between the parties with respect to the software, which is the subject of this 
Agreement, and supersedes any prior agreements. This Agreement may only be 
changed by mutual written consent. 

ADDITIONAL INFORMATION 

Additional information can be found in the User's Guide, or online at: 

http://www.windwardenv.com/biotic-ligand-model. 

 

http://www.windwardenv.com/biotic-ligand-model
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Contact Information 

For questions or problems, including bug reports, relating to the use and the 
application of the biotic ligand model (BLM) or the BLM Windows® Interface, please 
contact either: 

Robert Santore 
Windward Environmental LLC 
Phone: 206-812-5450 
E-mail: roberts@windwardenv.com 

or 

Kelly Croteau 
Windward Environmental LLC 
Phone: 206-812-5452 
E-mail: kellyc@windwardenv.com 

Additional information can be found online at:  

http://www.windwardenv.com/biotic-ligand-model. 

 

mailto:roberts@windwardenv.com
mailto:kellyc@windwardenv.com
http://www.windwardenv.com/biotic-ligand-model
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1 Introduction to the Biotic Ligand Model 

1.1 INTRODUCTION 

Metal bioavailability and toxicity have long been recognized to be a function of water 
chemistry (Sunda and Guillard 1976; Sunda and Hansen 1979). For example, the 
formation of inorganic and organic metal complexes and their sorption to particle 
surfaces can reduce metal toxicity. As a result, metal toxicity can be highly variable 
and dependent on ambient water chemistry when expressed as total or dissolved 
metal concentrations. In contrast, the effects of water chemistry on metal toxicity can 
often be reduced or eliminated when metal toxicity is related to free metal ion 
concentrations (Sunda and Guillard 1976). Allen and Hansen (1996) have shown the 
relationship between metal speciation and toxicity and have used this relationship to 
predict the range of effects that site-specific water quality characteristics can have on 
copper (Cu) toxicity.  

1.2 BLM FRAMEWORK AND CONCEPTUAL MODEL 

The biotic ligand model (BLM) was developed to incorporate metal speciation and the 
protective effects of competing cations into predictions of metal bioavailability and 
toxicity (Di Toro et al. 2001; Paquin et al. 1999; Santore et al. 2001; Santore et al. 2002). 
The BLM is based on a conceptual model similar to the gill site interaction model 
proposed by Pagenkopf (1983) and is conceptually similar to the free ion activity 
model (Morel and Hering 1993). The BLM incorporates a version of Chemical 
Equilibria in Soils and Solutions (CHESS) (Santore and Driscoll 1995) that was 
modified to include the chemical and electrostatic interactions described in the 
Windermere Humic Aqueous Model (WHAM) (Tipping 1994). Metal toxicity is 
simulated as the accumulation of metal at a biologically sensitive receptor, the “biotic 
ligand," which represents the site of action of acute metal toxicity. Inorganic and 
organic ligands can also bind metal, however, thereby reducing accumulation at the 
biotic ligand. By incorporating the biotic ligand into a chemical equilibrium 
framework that includes aqueous metal complexation, the relationship between free 
metal ion concentrations and toxicity is an inherent feature of the model. 

The BLM framework also incorporates the competitive effects of other cations that 
interact with the biotic ligand to mitigate toxicity. For example, at a fixed free metal 
concentration, as hardness increases, the increased calcium ion (Ca2+) competes with 
the free metal for binding sites at the biotic ligand. A higher free metal concentration is 
therefore required to achieve the same toxic effect in the presence of the elevated Ca2+ 
concentration. The BLM uses this competitive mechanism to simulate the reduction in 
metal toxicity due to elevated hardness concentrations. Thus, the BLM can effectively 
account for a reduction in metal toxicity caused by elevated levels of hardness cations 
(Meyer et al. 1999). 
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The BLM has been developed using published information on metal toxicity and biotic 
ligand accumulation as a function of water chemistry. The most comprehensive data 
compiled to date for use with the BLM are for Cu toxicity to fathead minnows 
(Pimephales promelas). The biotic ligand, or site of acute Cu toxicity for fathead 
minnow, has been identified as sodium (Na) ion uptake channels in the gill membrane 
(Playle et al. 1993a). Cu accumulation on the gill has been associated with respiratory 
distress and decreased blood plasma Na concentrations caused by interference with 
these sites (Playle et al. 1992). The adsorption of Cu to gill surfaces in the BLM has 
been calibrated to measurements of Cu accumulation on the gill over a wide range of 
water quality conditions (Playle et al. 1992; Playle et al. 1993b). Additionally, MacRae 
(1999) has established a dose response relationship necessary to determine the biotic 
ligand LC50 (concentration that is lethal to 50% of an exposed population) in rainbow 
trout. In the BLM, metal toxicity is defined as the amount of metal necessary to result 
in accumulation at the biotic ligand equal to the biotic ligand LC50. While others have 
developed models capable of predicting metal bioaccumulation on the gill under 
short-term exposure conditions (Playle et al. 1993a, b), the BLM is the first that 
includes a scheme for predicting toxicity. The BLM for other metals and organisms is 
based on a similar approach. 

1.3 BLM APPLICATIONS 

The BLM can be used to calculate the chemical speciation of a dissolved metal, 
including complexation with inorganic and organic ligands and the biotic ligand. The 
biotic ligand represents a discrete receptor or site of action on an organism where 
accumulation of metal leads to acute toxicity. The BLM, therefore, can be used to 
predict the amount of metal accumulation at this site for a variety of chemical 
conditions and metal concentrations (i.e., the inorganic, organic, and biotic speciation 
of metals in aquatic settings). 

According to the conceptual framework of the BLM, the accumulation of metal at the 
biotic ligand at or above a critical threshold concentration leads to acute toxicity. This 
critical accumulation on the biotic ligand is also termed the LA50 (accumulation of 
metal on the biotic ligand that is lethal to 50% of an exposed population) or, for 
example, the EA20 for chronic toxicity (accumulation of metal on the biotic ligand that 
causes a defined effect in 20% of an exposed population). The LA50 is expressed in 
units of nmol/g wet weight of the biotic ligand. Since the BLM includes inorganic and 
organic metal speciation and competitive complexation with the biotic ligand, the 
amount of dissolved metal required to reach this threshold varies, depending on the 
water chemistry. Therefore, in addition to calculating chemical speciation, the BLM 
can be used to predict the concentration of metal that would result in toxicity within a 
given aquatic system. 
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1.1.1 Fixed monitoring benchmark 

The fixed monitoring benchmark (FMB) is a single value that can be used to monitor 
compliance with the time-variable water quality criteria (WQC). The FMB uses a BLM 
toxicity calculation in combination with concurrent metal concentrations to calculate 
the likelihood of exceeding the WQC, and determines a safe value based on their 
continuous distribution functions. The theory and background of the FMB is not 
described in this user guide, only the use of the BLM in calculating the FMB. For more 
information on the FMB development and method of calculation, refer to Ryan et al. 
(2018). 
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2 Overview and Help File Layout 

2.1 WHAT'S NEW IN THIS DISTRIBUTION? 

In Version 3.41.2.45, several features have been added, various improvements to the 
software have been made, and several bugs have been fixed. Changes include: 

 A bug that prevented silver (Ag) from being run successfully with simple 
chemistry has been fixed. 

 A bug that prevented metals other than copper from being run successfully in 
toxicity mode has been fixed. 

 Units labeling has been fixed; unit conversion functionality in the simple 
chemistry tabs has been improved. 

 The Options menu is no longer a sub-menu of the Edit menu; the menu was 
becoming so large as to be unwieldly. 

 The BLM has been translated into French! This is thanks to support from 
Environment and Climate Change Canada. Translations are limited to the user 
interface, so labels in output files are only in English for the time being.  

 A new option for running large datasets has been added: “Run Batches...” has 
been added to the File menu so that datasets larger than the maximum number 
of observations can be run sequentially with minimal supervision.  

 Output files can now be written as CSV files. 

 The user can now look up median ion ratios by US state, Canadian province, 
Canadian ecozone, or Commission for Environmental Cooperation (CEC) 
ecoregion. 

 The FMB can now be calculated using WQC and HC5 (concentration 
corresponding to the 5th percentile of the species sensitivity distribution [SSD1]) 
parameter files. 

2.2 HELP FILE LAYOUT 

The remainder of this document describes the hardware and software requirements 
for installing and running the BLM Windows® Interface, details the data requirements 
of the BLM, and provides a step-by-step guide to using the various functionalities of 
the BLM Windows® Interface and a walk-through of the application using an example 
BLM data file.  

 

                                                 
1 Showing the range in organism sensitivity to a toxicant ordered from most sensitive to least sensitive. 
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3 Setup and Installation 

3.1 SYSTEM REQUIREMENTS 

The BLM Windows® Interface is designed for use on the PC family of computers 
running Microsoft Windows®. The memory requirements of the BLM Windows® 
Interface are modest and should not interfere with other resident programs.  

3.2 INSTALLING THE BLM WINDOWS® INTERFACE 

Installing from a setup file – To install the BLM Windows® Interface from the setup 
file “BLM_3.41.2.45_setup.exe,” simply double-click on the file and follow the 
prompts. The setup program (Figure 3-1) will guide the user through a fairly 
straightforward installation process, querying the user for information on where to 
install the necessary files. During the installation, a shortcut to the BLM Windows® 
Interface application will be added to the “Programs” sub-menu within the “Start” 
menu on the Microsoft Windows® desktop. In addition, the BLM Windows® Interface 
application will be registered in the system registry so that the BLM data files created 
by the user can be accessed directly by double-clicking on the file name. 

 

Figure 3-1. Opening screen for the BLM setup program 

Installing from a compressed (.zip) file – To install the BLM Windows® Interface 
from the compressed file, simply unzip the entire package to a folder in the 
Documents directory on your hard disk. If your zip utility asks if you would like to 
preserve paths, say “yes.” Do not try to run it from the desktop or a server folder, 
since that sometimes causes program errors. Once the zip file is unpacked, you can 
start the program by double-clicking on the file “BLM_UI.exe,” which will have a BLM 
icon.  
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4 Data Requirements 

4.1 FULL SITE CHEMISTRY 

The BLM predicts metal toxicity and speciation for a particular site based on ambient 
water quality. Therefore, the user will be expected to provide data describing the 
physical and chemical properties of the site water. The data requirements of the BLM 
are conventional physical and chemical parameters that are easily measurable in the 
laboratory; certain parameters may be measured in the field or laboratory depending 
on the purpose of the BLM simulation (e.g., pH and temperature, as discussed below). 
This section describes the general physical and chemical data requirements for an 
application of the BLM to predict metal speciation, toxicity, or WQC in aquatic 
systems. 

The ambient water quality information required to run the BLM is: 

 Temperature 

 pH 

 Metal concentration 

 Dissolved organic carbon (DOC) 

 Major cations (calcium [Ca], magnesium [Mg], Na, and potassium [K]) 

 Major anions (sulfate [SO4] and chloride [Cl]) 

 Alkalinity 

 Sulfide 

 Possible other components (e.g. nitrate [NO3] for Ag runs) 

For a given metal, some of these chemical inputs have an important effect on metal 
speciation, while other chemical inputs have only minor effects on BLM predictions. 
The user should be aware of the relative importance of each of the chemical inputs to 
decide whether adequate information is available for a meaningful application of the 
BLM. The guidelines described in the subsequent subsections may be helpful in that 
assessment.  

Each water sample must be fully described in terms of the above-listed water quality 
inputs before the BLM can be used. However, if some of the parameters are known to 
be absent in a water sample, a nominal, negligible concentration should be input (a 
value on the order of 1E-10 mg/L is typically sufficient) rather than a zero 
concentration. 
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The BLM also allows the estimation of major ions from hardness and ion ratios (see 
Section 0) or salinity and base marine chemistry (see Section 0), thereby allowing the 
model to run with only temperature, pH, DOC, and hardness or salinity. 

4.1.1 Temperature 

Temperature measurements are typically the most common and basic of all water 
quality measurements and therefore available in most laboratory characterizations of 
site water chemistry. Because the BLM is based on a thermodynamic chemical 
equilibrium modeling framework, temperature measurements are important in 
determining the relevant thermodynamic reaction rates. Note that laboratory 
temperature conditions are relevant when the BLM is being used to explain or predict 
toxicity tests conducted in the laboratory. Field temperatures, on the other hand, are 
more appropriate when using the model to extrapolate to field conditions. 

4.1.2 pH 

Accurate pH values are important to BLM results for most metals. The chemical 
speciation of many metals, such as Cu, is directly affected by pH. Sample pH is also 
important in determining the metal complexation capacity of dissolved organic 
matter, and in determining the speciation of inorganic carbon, which relates to the 
formation of metal carbonate complexes. For these reasons, pH is considered a 
required chemical input to the BLM. If BLM results are to be compared with 
laboratory measurements of metal toxicity, then it is preferable that the pH be 
measured within the test chamber during the exposure. Otherwise, use the field pH to 
extrapolate to field conditions. 

4.1.3 Dissolved organic carbon 

Dissolved organic matter can play a critical role in determining metal speciation and 
bioavailability. In the BLM, the presence of dissolved organic matter is specified as a 
DOC concentration expressed in mg/L and is considered a required input for the 
BLM. For water with low DOC, it is important to make sure that analytical detection 
limits are sufficiently low. In toxicity studies, the test organisms themselves may be a 
significant source of organic matter, depending on the number of organisms and the 
volume of the test chamber.  

Natural organic matter (NOM) is any organic component of the water; for example, 
leaf litter and detritus are common sources of organic matter. NOM is a complex 
mixture of organic acids, proteins, and many more complex organic molecules. Total 
organic matter can be broken down into particulate organic matter and dissolved 
organic matter. The accepted standard, although the exact cutoff is somewhat 
arbitrary, is that dissolved organic matter can pass through a 0.45-micron filter, 
whereas particulate organic matter gets caught in a filter that size. DOC is a way of 
quantifying dissolved organic matter and is simply the mass of carbon present in the 
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mixture of organic compounds. Sometimes total organic carbon (TOC) is reported 
instead of DOC. DOC is preferred for use in the BLM, but TOC can be used in lieu of 
DOC with the understanding that the actual amount of DOC will be less than the 
amount of TOC.  

It should not be expected that DOC from artificial sources (e.g. acetate, sugar, MOPS 
or other buffers, etc.) will behave as NOM. The organic matter binding model that the 
BLM uses is based on natural sources of organic matter, and inputs should therefore 
not include known quantities of artificial organic matter. If there is a significant 
amount of artificial organic carbon in the solution, then a speciation model that 
includes that chemical component may be necessary to accurately model it.  

4.1.4 Humic acid fraction of DOC 

The BLM uses a description of organic matter chemistry developed for WHAM, 
Version 1.0 (Tipping 1994), that characterizes metal complexation with both humic 
and fulvic organic matter sources.2 To be able to make use of this capability, it is 
necessary to specify the distribution of humic and fulvic acids in the organic matter 
present in a given water. Unfortunately, NOM composition is not routinely 
characterized, and information on humic and fulvic acid content is not likely to be 
available. In the absence of chemical characterization, a value of 10% humic acid (HA) 
content is recommended for most natural waters. The variability of the dissolved 
organic matter content in diverse water sources has not been found to be an especially 
critical parameter, and little benefit is achieved by characterizing NOM beyond DOC 
concentrations. 

4.1.5 Metal concentrations 

Metal concentrations are needed to run the model in speciation mode. It is not 
necessary to input metal concentrations for the model to calculate toxicity or 
instantaneous WQC/HC5; however, metal concentrations are required when 
calculating an FMB (see Sections 0 and 0). If the metal concentrations are censored (i.e., 
below the detection limit), then this can be indicated by making the number negative 
or using the “<” symbol before the number (e.g., if the detection limit is 0.2 µg/L, then 
enter either “-0.2” or “<0.2” in the metal column for observations that are below the 
detection limit). The censored data will display with the “<” symbol but will be stored 
as a negative number in the background (for computing purposes), so do not be 
confused if a censored value suddenly turns negative when you select a cell to edit it.  

                                                 
2 Note that this version of WHAM is sometimes called WHAM Model V, due to a change in the version 

numbering around that time. 
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4.1.6 Major cations 

The cations Ca, Mg, Na, and K are all necessary inputs to the BLM. For Cu and Ag, Ca 
and Na can compete directly with the metal at biotic ligand sites; these cations will, 
therefore, have a direct effect on predictions of metal toxicity. For some organisms, Mg 
may play a critical role as well. These cations, therefore, should be considered required 
inputs to the BLM. On the other hand, K currently has no direct effect on metal toxicity 
in the BLM and can be estimated if measurements do not exist. Although K does not 
have direct effects on metal toxicity, it is still often present in large enough quantities 
that it can affect the charge balance and ionic strength of the water. This would 
indirectly affect the metal toxicity, typically—but not always—to a small extent. 

4.1.7 Major anions 

The anions SO4 and Cl are necessary inputs to the BLM (although bicarbonate is also 

an important anion, as discussed in Section 0). In fresh waters, SO4 may be the 

dominant anion and is, therefore, important for determining charge balance and ionic 
strength. The chemistry of metals and NOM is dependent, to varying degrees, on ionic 
strength, so SO4 has some importance as a BLM input. If measurements of SO4 are not 

available, however, the concentrations can be estimated. For Cu and most other metal 
simulations, Cl is only important as a contribution to ionic strength, but for Ag 
simulations, Cl can have additional importance due to the formation of Ag-Cl 
complexes. Therefore, it is preferable that only measured Cl concentrations be used for 
BLM applications involving Ag, while estimates can be used for applications involving 
other metals. 

4.1.8 Alkalinity 

Inorganic carbon species in the BLM include carbonate (CO3
2−), bicarbonate (HCO3

−), 
and carbonic acid (H2CO3). The sum of these species is referred to as dissolved 
inorganic carbon (DIC). Bicarbonate is usually the most important DIC species in 
natural waters, because it is the dominant species between pH 6.35 and 10.33. 
Inorganic carbon is a critical input to the BLM because many metals form carbonate 
complexes. The one exception is Ag, which does not form carbonate complexes; DIC is 
not a critical input to BLM applications for Ag. Unfortunately, measurements of DIC 
are not often taken in natural water samples, but DIC can be estimated from alkalinity 
and pH measurements, as in Equation 4-1.  
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where:  

Alk = alkalinity in equivalents/L  

= 2 x 10
-5

 x alkalinity (as mg calcium carbonate [CaCO3]/L) 

[H] = 10
-pH

 

K1 = 10
-6.352

 

K2 = 10
-10.329 

The BLM Windows® Interface uses this equation to calculate the DIC internally, so 
only the alkalinity and pH need to be specified. Alkalinity should be measured on 
filtered samples to eliminate potential contribution from suspended calcium carbonate 
(CaCO3) and expressed in units of mg/L CaCO3. If there are chemical additions that 

affect alkalinity but not DIC, those quantities should be excluded from the input 
alkalinity concentrations. However, depending on the inorganic carbon option 
selected, the user may also opt to specify DIC concentrations directly, or choose to 
have the BLM calculate the DIC that would result from atmospheric CO2 being in 
equilibrium with site chemistry. This last option assumes a pCO2 of 10-3.2 by default (or 
whatever value is entered into the pCO2 input box on the Simplified Site Chemistry 
tab; see Sections 0 and 0), and calculations are done within the BLM engine. It differs 
from the atmospheric alkalinity calculation used when converting between simple and 
full site chemistry (see Section 0) in that all of the chemical equilibria equations are 
considered, not just carbonate equilibria equations. 

4.1.9 Sulfide 

Although it has traditionally been assumed that sulfide concentrations are negligible 
in aerated waters, recent evidence suggests that appreciable sulfide concentrations 
persist in both marine and fresh waters. Waters affected by wastewater treatment 
plant effluents in particular can have elevated sulfide concentrations. Sulfide has a 
strong affinity for many metals, so it is an important consideration in determining 
metal speciation and bioavailability. Therefore, if sulfide is present, measured sulfide 
should be considered a required input to the BLM, especially when sulfide 
concentrations are similar to the predicted effect levels for a given metal and 
organism.  

Researchers at several universities continue to look into the nature of sulfide-metal 
complexes in aqueous systems. The persistence of sulfide in aerated waters may be 
linked to the formation of stable metal-sulfide clusters, and these clusters may not be 
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detected by traditional sulfide measurements. Alternatively, strong metal complexes 
believed to be due to sulfide compounds may actually be due to other forms of 
reduced sulfur that are also missed by traditional sulfide measurements. Suitable 
analytical methods that measure the target form of sulfide and do not measure other 
non-reduced forms of sulfur are under development. Also, sulfide levels in some 
locations may be known to be low and well below the effect levels of interest for a 
given metal. Therefore, sulfide measurements may not be critical in all instances.  

Since these research questions are still being addressed, metal-sulfide reactions have 
not yet been incorporated into the BLM. The sulfide column in the input file is a 
reminder that these interactions are likely to be added to subsequent versions of the 
model. Sulfide concentrations added in that column will not affect the BLM 
calculation. It is recommended that typical users enter a near-zero concentration as a 
default value (i.e., 1.0E-10 mg/L). When sulfide reactions are omitted from model 
simulations, the BLM will always predict a lower (i.e., more protective) estimate of a 
concentration associated with toxicity. 

4.1.10 Other components 

The current marine chemistry file also includes phosphate (PO4) as a component. PO4 

does have reactions associated with it, and measured concentrations should be entered 
if available. PO4 can bind very strongly with some metals and may affect solubility. If 
no PO4 measurements are available, it is suggested that the user estimate them with 
salinity and base marine chemistry (see Section 0).  

Parameter files for silver include a NO3 component as well, and measured 
concentrations should be included if available. It is also possible, through the use of a 
user-generated parameter file, to have other non-standard components (recommended 
for advanced users only). Typically, when a non-standard component is included in a 
parameter file, it is because it will have a significant effect; measured concentrations 
should be entered whenever possible. 

4.2 SIMPLIFIED SITE CHEMISTRY 

In addition to the full site chemistry, the model can be run with simplified site 
chemistry inputs. “Simplified Site Chemistry” differs from (full) “Site Chemistry” in 
that there are fewer inputs required for each site, making data collection easier. The 
ionic composition of the water is estimated based on some aggregate measure of ionic 
strength and assumed values of the relative compositions of the ions. The ambient 
water quality requirements to run the BLM with simplified site chemistry are: 

 Temperature 

 pH 

 Metal concentration (not required in toxicity mode) 
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 DOC 

 Freshwater only: 

 Hardness 

 Ion ratios (default values may be used if unknown) 

 pCO2 (defaults to 3.2) 

 Marine only: 

 Salinity 

 Base marine chemistry 

The requirements for temperature, pH, metal concentration, and DOC are the same as 
for full site chemistry (see Section 4.1). The ion ratio and pCO2 or base marine 
chemistry values can be changed to match the particular conditions of the site or test. 

4.2.1 Freshwater simple chemistry 

While in freshwater mode, the ionic composition of the water will be estimated based 
on measured hardness values and median, assumed, or regional ion ratios. The 
alkalinity will be estimated based on atmospheric alkalinity.  

4.2.1.1 Hardness 

The hardness measurement is used, with pH and ion ratios, to estimate the major 
cations and anions. Hardness is typically the total Ca and Mg ion concentrations, 
although if hardness is measured directly, other ions can sometimes affect it also. For 
this calculation, hardness is assumed to be equivalent to Ca + Mg, expressed in units 
of mg/L CaCO3.  

4.2.1.2 Ion ratios 

The ion ratios determine the proportion of each ion that makes up hardness and the 
charge balance of the water, so Ca:Mg is the ratio of Ca ions to Mg ions (in mol/L). 
These ratios will vary among water samples depending on watershed geology and 
various inputs. The default values are median values based on water quality 
monitoring data from across the United States and Canada. The data used to calculate 
these values are publicly available. The user may also select values specific to a 
Canadian ecozone (Ecological Stratification Working Group 1995) or province, or US 
state or ecoregion based on the delineations of the CEC (Commission for 
Environmental Cooperation 1997). Ecozones and ecoregions are ecologically and 
geologically similar regions that are groups at various spatial scales. The CEC has 
three spatial scales, Level I being the broadest and Level III being the finest. Canadian 
ecozones generally have borders that are the same as or very similar to CEC Level I 
ecological regions, with a few ecozones corresponding to Level II ecological regions 
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instead. The data for these smaller delineations are the same as for the default North 
American values. 

4.2.1.3 pCO2 

Alkalinity is estimated from pH assuming an open system in equilibrium with CO2 in 
the atmosphere. The relatively small differences between indoor and outdoor CO2 
concentrations may significantly affect the calculated alkalinity. For this reason, the 
user is allowed to adjust the pCO2 value (i.e., ambient CO2 concentration in 
atmospheres). In most natural settings, it is a reasonable assumption that the CO2 
concentration will be 10-3.5 atmospheres, but for indoor settings (where many toxicity 
tests are performed) this might not be the case. CO2 concentrations are typically higher 
indoors, resulting in a lower pCO2 value. Most indoor air quality standards suggest 
CO2 to be at concentrations of less than 10-3 atmospheres, so the pCO2 should generally 
be greater than 10-3.5 and less than 10-3.0 atmospheres. The indoor CO2 concentration 
depends on the amount of ventilation and respiration occurring in the building, and 
there would not be any physical effects from CO2 until it reached much higher 
concentrations than 10-3 atmospheres. Hence, pCO2 values greater than 10-3 
atmospheres are possible but not likely.  

4.2.1.4 Simple to full chemistry conversion process 

When the user switches from the “Simplified Site Chemistry” tab to the full “Site 
Chemistry” tab, the software copies the labels, temperature, pH, DOC, and copper 
concentrations to the full chemistry input grid. Then the pH and pCO2 are used to 
estimate alkalinity, and the hardness and ion ratios are used to estimate the major ion 
concentrations.  

Alkalinity is estimated with the assumption that carbonate species are in equilibrium 
with atmospheric CO2, following Henry’s Law. The following equations perform this 
operation: 

 
[𝐻2𝐶𝑂3

∗] = 𝐾𝐻 ∗ 𝑃𝐶𝑂2
 Equation 4-2a 

[𝐻𝐶𝑂3
−] = 10−6.352 ∗

[𝐻2𝐶𝑂3
∗]

[𝐻+]
 Equation 4-2b 

[𝐶𝑂3
2−] = 10−10.329 ∗

[𝐻𝐶𝑂3
−]

[𝐻+]
 Equation 4-2c 

[𝐴𝑙𝑘 (
𝑚𝑔

𝐿
 𝑎𝑠 𝐶𝑎𝐶𝑂3)] = ([𝐻𝐶𝑂3

−] + 2 ∗ [𝐶𝑂3
2−] + [𝑂𝐻−] − [𝐻+]) ∗ (

100086

2
)

 Equation 4-2d 
 

where [H2CO3
∗ ] is the sum of dissolved CO2 gas and the carbonic acid (H2CO3) species, 

𝐾𝐻, is Henry’s Law constant (equal to 10-1.5 M/atm), so that with the default pCO2 
value of 10-3.2, the concentration of [H2CO3

∗ ]= 10-4.8 M. The alkalinity is then pH 
dependent (e.g., the alkalinity is 4.44 mg/L CaCO3 when the pH is 7). At low pH, this 
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calculation will often yield a negative alkalinity, which is replaced with an alkalinity 
of 1 mg/L CaCO3 to avoid errors. 

The hardness is converted to ion concentrations using the ion ratios and a charge 
balance. Calcium concentrations are calculated first, as: 
 

[𝐶𝑎2+] = (
𝐻𝑎𝑟𝑑𝑛𝑒𝑠𝑠 𝑎𝑠

𝑚𝑔

𝐿
𝐶𝑎𝐶𝑂3

100086
𝑚𝑔

𝑚𝑜𝑙

) ∗ (
𝐶𝑎:𝑀𝑔

𝐶𝑎:𝑀𝑔+1
)  Equation 4-3 

 
The remaining cations are calculated as: 

 

[𝑋] =
[𝐶𝑎2+]

𝐶𝑎:𝑋
 Equation 4-4 

 

where X is Mg, Na, or K. The anions, SO4 and Cl, are calculated by first calculating the 
anion deficit: 

 

𝐷𝑒𝑓𝑖𝑐𝑖𝑡 (
𝑒𝑞

𝐿
) = 2 ∗ [𝑆𝑂4

2−] + [𝐶𝑙−] Equation 4-5 

= 𝛴(𝑐ℎ𝑎𝑟𝑔𝑒 ∗ 𝐶𝑎𝑡𝑖𝑜𝑛𝑠) − 𝛴(𝑐ℎ𝑎𝑟𝑔𝑒 ∗ 𝐴𝑛𝑖𝑜𝑛𝑠)  
=  (2 ∗ [𝐶𝑎2+] + 2 ∗ [𝑀𝑔2+] + [𝑁𝑎+] + [𝐾+] + [𝐻+])

− ([𝑂𝐻−] + [𝐻𝐶𝑂3
−] + 2 ∗ [𝐶𝑂3

2−]) 
 

Then, the concentrations of SO4 and Cl are calculated as follows: 
 

[𝑆𝑂4
2−] =

𝐷𝑒𝑓𝑖𝑐𝑖𝑡

2+
1

𝑆𝑂4:𝐶𝑙

 Equation 4-6a 

[𝐶𝑙−] =
[𝑆𝑂4

2−]

𝑆𝑂4:𝐶𝑙
 Equation 4-6b 

 

If there is a negative deficit, the concentration of SO4 would be calculated as a negative 
number: an impossible condition. In such cases, [SO4

2−] is set at an arbitrary low 
number (10-7 mol/L) before calculating [Cl−] in order to avoid errors. 

4.2.2 Marine simple chemistry 

While in Marine mode, the ionic composition of the water will be estimated based on 
measured salinity values and base marine chemistry. Inorganic carbon is also based on 
the base marine chemistry, not an atmospheric estimate like in the hardness-based 
simple chemistry.  
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4.2.2.1 Salinity 

Salinity should be input using units of parts per thousand (ppt). Full chemistry is 
calculated from salinity and base marine chemistry. It should be noted that the BLM 
interface estimates full ion chemistry from salinity under the assumption that 
estuarine water is essentially diluted sea water with negligible ionic inputs from the 
freshwater source. This assumption is not valid in some cases, namely when the 
estuarine water’s salinity approaches that of freshwater, or when the estuary’s 
freshwater source has a high hardness. For example, when the freshwater input to an 
estuary has a hardness of 100 mg/L CaCO3 and the estuarine water has a salinity of 
10 ppt, the estimated ion concentrations will differ from actual by about 14% for Ca, 
2% for Mg, 0.3% for Na, 1% for K, 6% for SO4, and 1% for Cl. However, a similar 
magnitude of departure from actual concentrations is seen at only about 25 ppt when 
the freshwater input has a hardness of 500 mg/L CaCO3. 

4.2.2.2 Base marine chemistry 

The base marine chemistry is the chemistry that would be expected from full-strength 
sea water. This defaults to sea water with a salinity of 35 ppt, Ca of 10.02 mmol/L, Mg 
of 51.48 mmol/L, Na of 457.12 mmol/L, K of 9.950 mmol/L, SO4 of 27.52 mmol/L, Cl 
of 532 mmol/L, DIC of 1.998 mmol/L, and PO4 of 2.33 mmol/L.  

4.2.2.3 Simple to full chemistry conversion process (salinity) 

The Ca, Mg, Na, K, SO4, Cl, and PO4 ions and DIC are all calculated from salinity and 
base marine chemistry. The calculation assumes that the contribution from fresh water 
is negligible, and therefore the concentrations of ions and DIC are proportional to the 
base chemistry as per the following equation: 

 

[𝑋] =
(𝑆𝑎𝑙𝑖𝑛𝑖𝑡𝑦)∗[𝑋]𝑏𝑎𝑠𝑒

(𝑆𝑎𝑙𝑖𝑛𝑖𝑡𝑦)𝑏𝑎𝑠𝑒
 Equations 4-7 

 

where [X] is the concentration of one of the ions or DIC and “base” denotes the values 
from the base marine chemistry. As noted, this relationship breaks down when the 
freshwater source has high hardness, or when the site is near the freshwater source 
(i.e., has a low salinity). In those cases, it is best to measure the full chemistry of each 
sample, or to manually estimate the full chemistry while taking the freshwater 
source’s ions into account.  

4.3 MINIMUM DATA REQUIREMENTS 

The BLM can be run with observations numbering from 1 to 1,000. In toxicity mode, a 
corresponding number of instantaneous WQC values will be calculated. Any 
observations with missing chemistry will be skipped in the calculation process. 
Missing metal concentrations will not prevent an observation from being run in 
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toxicity mode, since the metal concentration is the component being calculated. 
However, calculation of the FMB will require metal concentrations and at least 10 
complete observations (including metal). See Section 0 for a full description of the 
required chemistry inputs.  

4.4 DATA TEMPLATE 

To assist users in collecting and organizing the information required to run the BLM, a 
BLM Data Template is now installed in the data directory of all new installations, and 
is available online (www.windwardenv.com/biotic-ligand-model/). The template is in 
Microsoft Excel®.xlsx format and contains two data template sheets in the workbook, 
one for toxicological data (“Toxicity Data Template”) and one for site chemistry (“Site 
Chars Data Template”). The word “METAL” in some of the column headers should be 
replaced with the metal of concern when entering data. Although it is expected that 
the data in the Site Chars Data Template sheet will mostly be used in toxicity mode, 
metal concentration columns are still included to make it easier to compare to the 
predicted HC5/WQC, and also to make the template usable to set up inputs for FMB 
calculations.  

The user should fill in this template to the greatest extent possible when preparing 
data for use in the BLM. If water quality parameters need to be estimated, it is 
suggested that the green columns be copied to the right of the table and filled in with 
the estimated values there, making it clear which ones are the estimated values and 
which are the measured/reported. 

 

http://www.windwardenv.com/biotic-ligand-model/
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5 Running the Application 

The following subsections describe how to use the software, the various functions and 
features available in the BLM Windows® Interface, and the use of the BLM with its 
various predictive capabilities. 

5.1 STARTING THE APPLICATION 

To start using the BLM Windows® Interface, the user should select the application 
using “Start -----> Programs -----> Biotic Ligand Model -----> Biotic Ligand Model, 

Version 3.16.2.41” on the Microsoft Windows® desktop. The user will be presented 
with the screen shown in Figure 5-1, which contains the user input areas and the 
various functions included in this version of the BLM Windows® Interface. 

 

Figure 5-1. Opening screen for the BLM Windows® Interface application 

If the user already has a BLM data file created using the BLM Windows® Interface, the 
file can be opened directly by double-clicking on the file name through a file system 
manager, such as Microsoft Windows® Explorer. 

5.2 DESCRIPTION OF INTERFACE 

Figure 0-1 shows a snapshot of the BLM Windows® Interface application. The main 
purposes of this section of the interface application are:  

 To provide an easy-to-use editor to develop input files containing water 
chemistry information for the BLM 

 To facilitate checks and validate user inputs for the various parameters 
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 To perform checks on whether the values entered for any given parameter are 
within the range for which the BLM has been calibrated 

 To run the BLM for predictions of aquatic speciation or toxicity for a variety of 
metals and organisms  

 

Figure 0-1. Snapshot of the BLM Windows® Interface 

As shown in Figure 0-1, the interface window is divided into seven areas broadly 
based on their functionality. Each of these is described in the subsections that follow. 

5.3 SITE CHEMISTRY INPUTS TAB 

This region of the interface window contains a spreadsheet-based editor, which 
organizes the various BLM input parameters in a columnar format such that the 
chemistry for each discrete water sample can be specified in a separate row. Apart 
from the water chemistry information, two additional columns are also provided for 
labeling the sites and samples described in a given BLM data file. Figure 0-2 shows the 
various columns typically available for user input. See Section 0 for a full description 
of each of the required chemistry inputs and their importance in the model. 
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Figure 0-2. Columns for data input in the BLM Windows® Interface 

The first column, “Site Name,” is meant to contain information about the site under 
consideration. For example, it could be the name of the river or site ID if the same file 
contains water chemistry data for more than one location along a particular river. The 
“Sample Name” field can be used to distinguish among the various water chemistry 
samples available for a particular site. For instance, at a given site, this field could 
represent the date and time at which the site water samples were collected. For both 
the site and the sample descriptor fields, the maximum number of characters allowed 
in each field is 20. 

5.4 SIMPLE CHEMISTRY INPUTS TAB 

By clicking on the “Simplified Site Chemistry” tab, a grid similar to the full site 
chemistry data inputs will be displayed, as shown in Figure 0-3 for freshwater mode 
and Figure 5-5 for marine mode. The contents of the tab will be slightly different 
depending on whether the software is in freshwater or marine mode. The “Simplified 
Site Chemistry” view is an alternate place where the user can save chemical 
characterization of the water chemistry. See Section 0 for a description of the required 
chemistry inputs for this tab.  
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Figure 0-3. Snapshot of Simplified Site Chemistry inputs and ion ratios 

 

Figure 0-4. Snapshot of Simplified Site Chemistry (Salinity) inputs and base 
marine chemistry 
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The ion ratios and pCO2 or base marine chemistry can be viewed and edited in a side 
bar with editable boxes, and can be returned to the starting values at any time by 
clicking the “Restore Default Values” button. If ion ratios or base marine chemistry are 
unknown for the water source being considered, use the default values in the boxes or 
(for freshwater mode) select the ecozone, ecoregion, state, or province the water source 
is in from the “Select Ion Ratios...” dialog. The “Select Ion Ratios...” button will open a 
dialog so that the user may select values specific to a Canadian ecozone (Ecological 
Stratification Working Group 1995) or province, or US state or ecoregion based on the 
delineations of the CEC (1997). The pCO2 is inserted in a box to the right of the grid, 
below the ion ratios in freshwater mode. The value to be entered is the negative 
logarithm of the actual pCO2 value. 

While in the “Simplified Site Chemistry” tab, clicking the “Open” option will filter for 
files with the extension “.blme” rather than “.blm” in freshwater mode, or with 
“.swblme” rather than “.swblm” in marine mode. The “.blme” and “.swblme” file 
types save the ion ratios and base marine chemistry, respectively. An example of each 
of these files is included with the software download. 

After the simplified site chemistry data has been inserted into this grid, simply run the 
BLM as normal. Alternatively, the user can select the “Site Chemistry” tab again to 
have the full site chemistry estimated. This is helpful if only some of the chemistry 
needs to be estimated, since the user can use any measured values to replace the 
estimated values in the “Site Chemistry” tab, ultimately resulting in a better prediction 
of toxicity. Switching from the simplified tab to the full chemistry tab is a one-way 
conversion—the user cannot go back to the simple chemistry inputs after converting. 

5.5 MENU BAR 

Located at the very top of the interface window, the menu bar provides the user with a 
range of functions and features, including: 

 Mechanism for managing the BLM data files 

 Text editing functions  

 Model and output options 

 Options relating to data inputs 

 A help function 

 Language selection 

These features are described in the sections that follow. 

5.5.1 File 

Figure 0-5 shows the functions available under this menu item. Basic file management 
utilities to create a new BLM data file, open an existing BLM data file, and save a BLM 
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data file are provided. The user can also open a dialog to run batches from this menu 
(see Section 5.12) or open a file that was previously used (only the last five files are 
accessible via this dialog). 

 

Figure 0-5. Snapshot of file menu item 

Shortcut keys (shown to the right of each item) are also available for all of the different 
functions in the “File” menu.  

For ease of access, BLM data files can also be opened directly by double-clicking on the 
BLM data file in a file system manager, such as Microsoft Windows® Explorer. This 
avoids having to first start the application and then locate the BLM data file of interest.  

Note that the BLM data files created by the interface application are given a “.blm” 
extension in freshwater mode and a “.swblm” extension in marine mode by default. 
Even though the BLM data file created by the interface application basically is an 
ASCII text file, it is recommended that the user not modify this file using a program 
other than the BLM Windows® Interface application, as doing so may result in the 
BLM data file becoming corrupted. If this happens, the next time the user tries to edit 
that BLM data file using the BLM Windows® Interface, the file may not be read 
correctly by the BLM interface application.  

5.5.2 Edit 

Figure 0-6 shows the editing functions available in the BLM Windows® Interface. Basic 
editing functions such as “Cut,” “Copy,” and “Paste” are available in the interface 
application. The editing functions can be performed on a single or multiple cells by 
highlighting and dragging the cell(s), or by using the Shift and Arrow functions on the 
keyboard. These editing functions can also be accessed by using the shortcut keys 
shown to the right of each. Note that it is also possible to copy and paste data from 
external programs, such as a spreadsheet application, into the BLM Windows® 
Interface.  
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Figure 0-6. Snapshot of edit menu item 

5.5.3 Options 

Figure 0-7 shows the “Options” menu. There are the options to save output as 
Microsoft® Excel (*.xls), space-delimited (*.txt), or comma-delimited (*.csv), and to 
show the BLM “engine” window while the model is running. The latter option has 
been added so that the user can see when the BLM run gets stuck on an observation, as 
the window shows the progress through the observations. The BLM engine 
occasionally encounters a problem that it cannot overcome, and it will not proceed as 
normal. This is more likely with a toxicity mode run than a speciation run, since the 
optimization may fail to converge. The problem can usually be fixed by changing the 
order of the observations so that there is a different starting point for the optimization.  

 

Figure 0-7. Snapshot of options menu item 

The second set of options is for determining the behavior of the program in relation to 
calculating the FMB. One menu item can be un-checked to have the program not 
calculate the FMB. The second item gives the user the option of the center statistic to 
use when the FMB is calculated. The center statistic can be calculated as the median or 
the geometric mean. With a perfectly lognormal distribution, both options would give 
the same answer, but if the distribution’s shape is odd, then the geometric mean tends 
to give a better answer. 
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5.5.4 Inputs 

Figure 0-8 shows the options available under the “Inputs” menu item. The units for all 
parameters can be changed by selecting the “Set Units” menu item. When changing a 
unit for a given parameter, data already input for that parameter can be converted to 
the new unit to prevent any loss of data. The “Set Inorganic Carbon” menu item can be 
selected to change how the user inputs inorganic carbon in the full “Site Chemistry” 
tab. There are two options to input inorganic carbon in closed systems: DIC or 
alkalinity. The third option is for an open system, in which the inorganic carbon is in 
equilibrium with the atmosphere. See Section 0 for further discussion of the inorganic 
carbon options. The “Set Exceedance Frequency” menu item is for setting the 
exceedance or return period for the FMB calculation. It can be specified as either days 
or years, and the ZEF (inverse normal) value will be displayed below the input boxes. 

 

Figure 0-8. Snapshot of inputs menu item 

The “Water Type” submenu item lets the user toggle between freshwater and marine 
environments for the simulations. This will change some of the inputs that are needed 
and the format of the “Simplified Site Chemistry” tab (hardness- or salinity-based, 
respectively), and will bring up the metal and organism selection screen for the user to 
choose an appropriate parameter file for their simulation. The user should select the 
water type before entering data into the input grid, since the input grid will be cleared 
when switching to a new water type. 

5.5.5 Help 

Figure 0-9 shows the various features available under the “Help” menu item.  

  

Figure 0-9. Snapshot of help menu item 
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The User’s Guide for the BLM Windows® Interface can be accessed via this menu item. 
In addition, under the “About BLM” sub-item, there is information on contacts for 
technical support. The “Create Debug Log” option will direct the program to make a 
detailed log of everything that happens in it, which is useful for sending to the 
developers if a problem is occurring. 

5.6 SHORTCUTS MENU 

Icons located on the toolbar provide shortcuts to some of the menu bar items, as well 
as additional functions that are not available on the menu bar. Figure 0-10 shows the 
various icons and their functions; brief descriptions are provided in the subsections 
that follow.  

 

Figure 0-10. Shortcut menu icons 

5.6.1 Open file 

This is a shortcut to the menu bar item under “File -----> Open” and serves as a quick 
was to access the BLM data files. If the BLM data file being edited has changed since 
the last time it was saved and the user tries to open another file, the user will be 
queried as to whether the current data file should be saved prior to opening another 
data file. 

5.6.2 Save file 

This is a shortcut to the menu bar item under “File -----> Save” and serves as a quick 
way to save the BLM data file. The data file will be saved with the same, existing 
name. If the user wishes to save the file under a different file name, the menu bar item 
“File -----> Save As” should be chosen. 

5.6.3 Metal/organism selection 

As mentioned, the BLM can be used to study the toxicity and speciation of a variety of 
metals and organisms. This action button is provided to allow the user to select the 
metal and the organism for which toxicity or speciation needs to be predicted. Clicking 
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on this icon will present the user with the window shown in Figure 0-11. The user can 
then choose the desired metal and organism for the BLM predictions. The current 
metal and organism selections are displayed in the “Current Selection” display area 
(see Figure 0-1).  

 

Figure 0-11. Metal and organism selection options 

Acute and chronic parameter files have been developed for several metals in 
freshwater and marine environments, and they will be added to the package as they 
are finalized. Unless otherwise specified, the available parameter files are currently for 
acute effects.  

5.6.3.1 Metal and organism options  

The metal- and organism-specific parameter files that are included in the current 
distribution of the BLM Windows® Interface can be accessed by selecting the 
“Pre-defined” tab button, then selecting first the metal and then a row from the table, 
as shown in Figure 0-11. The user can resize the column widths by clicking and 
dragging between two column headers. The user can sort the table by any of the 
columns by clicking on the column header (sorting will cycle through original-, 
descending-, and ascending-order sorting). Note that the organism-, life stage-, and 
endpoint-specific options available in the table are subject to change as part of the 
ongoing refinement of the calibration and application of the BLM, and may therefore 
undergo revisions from time to time.  

In order to provide enough information to accommodate chronic endpoints, a new 
parameter file format was created for starting in this distribution. Old parameter files 
only contained information about the organism; nothing about the life stage, endpoint, 
references, or methods was in any format that could be interpreted by the BLM 
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Windows® Interface program. In order to make the old parameter files available to 
users, many of the columns in the table will be blank for some metals and organisms, 
until we have converted everything to the new parameter file format. 

It is recommended that the user develop separate BLM data files for separate metals, 
even though the application of the BLM may be for the same set of observations. The 
current distribution of the BLM can be applied to only one metal at a time. Because the 
input metal concentrations in the BLM Windows® Interface “Site Chemistry” tab grid 

are expressed in units of g/L, the interface application internally converts these to 
mol/L using the molecular weight for the metal selected by the user when saving the 
input file. Changing the metal for the BLM application within an existing data file 

developed for a different metal may result in an erroneous conversion from g/L to 
mol/L when the user saves and opens the data file the next time. 

5.6.3.2 User-defined files 

In addition to the metal- and organism-specific parameter files that are included with 
the current distribution, users may opt to develop and use their own versions of these 
files for BLM predictions. This is achieved by selecting the “User-defined” tab button 
shown in Figure 0-11 and clicking “Select Parameter File…” to browse for the desired 
parameter file. New parameter files can be developed by the user along the lines of the 
parameter files supplied with this distribution (i.e., files with the extension “.dat” 
located in the “Model” sub-directory within the BLM directory in Program Files). Note 
that the user should first select the appropriate parameter file when opening a BLM 
input file that was previously developed for a user-selected parameter file.  

5.6.3.3 EPA WQC & HC5 Calculations 

The US Environmental Protection Agency’s (EPA’s) nationally recommended ambient 
water quality criteria (AWQC) for Cu are based on the BLM (EPA 2007). The ability to 
calculate criteria has been included in previous publicly available BLM software 
versions (2.2.1, 2.2.3) and is included in this version of the BLM Windows® Interface. 
The freshwater Cu AWQC can be generated by selecting the “EPA WQC” tab button 
shown in Figure 0-11, and then selecting “Cu” in the “Select Metal” drop-down menu. 
When the BLM is run in the Cu WQC mode, it generates the EPA (2007) freshwater 
dissolved Cu WQC (acute and chronic) for each row of input and provides these 
results in the “WQC” report (see Section 5.10) (Figure 5-13). The report provides the 
BLM-based final acute value (FAV) and the acute instantaneous water quality criteria 
(IWQC) (which is calculated as the FAV divided by two; see EPA 2007). The acute and 
chronic criteria are also known as the criterion maximum concentration (CMC) and 
criterion continuous concentration (CCC), respectively. If dissolved Cu input data are 
provided by the user in the BLM input data file, the values are tabulated in the criteria 
output file and used to calculate acute and chronic toxic units (TUs). These TUs are 
computed as the ratio of the input dissolved Cu concentration to the IWQC output for 
each input row, with TU values >1 indicating a potential exceedance of the particular 
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Cu IWQC. Given the basis of EPA’s aquatic life WQC derivations (Stephan et al. 1985), 
a TU >1 does not explicitly mean actual toxicity would be expected to occur. Rather, it 
simply indicates an exceedance of the particular magnitude of the criterion. 

 

Figure 0-12. Instantaneous copper criteria report 

The acute and chronic HC5 option is available for other metals for which 
BLM-normalized toxicity data have been used to construct a SSD, which was then 
used to calculate the 5th percentile of organism sensitivity. The BLM-predicted HC5 
can be interpreted in a manner similar to EPA’s derivation of aquatic life WQC, but 
HC5 calculations have not been reviewed and adopted by EPA. 

For additional information on the terminology and the exact workings of the WQC 
calculation, the user is advised to refer to EPA (2007). The criteria report shown in 
Figure 5-13, being in Microsoft® Excel file format, can also be copied for pasting onto 
any external application or report.  

5.6.4 Prediction mode 

The BLM Windows® Interface application allows the user to run the BLM in either 
toxicity mode or speciation mode. When run in toxicity mode for a metal and 
organism specified by the user, the BLM will predict the amount of metal required to 
cause acute or chronic toxicity in each observation/line in the input file. However, 
when the BLM is run in speciation mode for a metal concentration specified by the 
user, the BLM will predict the organic and the inorganic chemical speciation in the 
water column and the metal accumulation on the biotic ligand that would result.  

The “Prediction Mode” button allows the user to toggle between the speciation and 
toxicity prediction modes in the BLM. The current prediction mode is also displayed 
in the “Current Selection Display” area (see Section 5.7). The current prediction mode 
setting is saved when the application is closed, and the application will default to the 
last prediction mode used. 
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5.6.5 Check inputs 

In order to provide users with an idea of the range of water chemistry to which the 
BLM can be applied, the range of parameter values to which the BLM has been 
developed and calibrated is defined in the BLM Windows® Interface application. After 
creating a BLM data file, the user may wish to check the water chemistry inputs to 
verify whether the parameter values are within the overall range for which the BLM 
has been calibrated, and to check whether all the parameters necessary for a BLM 
prediction have been specified. Clicking the “Check Inputs” icon generates an input 
check report that contains information on which parameters are out of range (i.e., too 
high or too low when compared with the range for which the BLM has been 
calibrated) and which parameters are missing for any given input row. The ranges 
prescribed for each of the BLM input parameters are shown in Table 0-1. A range 
represents the minimum and maximum of the parameter values observed in toxicity 
studies of several metals. They are sometimes just a range of values that would be 
believable for a parameter in a natural setting. These ranges are meant to help the user 
find erroneous data but are not true model validation/calibration ranges. The BLM 
will still run when input data are outside of these ranges, and it is up to the user to 
evaluate whether chemistry in these cases is relevant for the organism under 
consideration. Figure 5-14 shows an example of an input check report. 

Table 0-1. Prescribed ranges for BLM input parameters 

Parameter Lower Bound Upper Bound 

Temperature (°C) 10 25 

pH 4.9 9.2 

DOC (mg/L) 0.05 29.65 

Humic acid content (%) 10 60 

Calcium (mg/L) 0.204 120.24 

Magnesium (mg/L) 0.024 51.9 

Sodium (mg/L) 0.16 236.9 

Potassium (mg/L) 0.039 156 

Sulfate (mg/L) 0.096 278.4 

Chloride (mg/L) 0.32 279.72 

Alkalinity (mg/L) 1.99 360 

DIC (mmol/L)a 0.056 44.92 

Sulfide (mg/L) 0.001 0.006 

Hardness (mg/L) 7.9 525 

Salinity (ppt) 5 38 

All other parameters (mol/L) 0 1E+6 

a DIC is included because it is an alternate input to alkalinity. Since the conversion to DIC from alkalinity is pH 
dependent, a separate range was determined for alkalinity. 
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DIC – dissolved inorganic carbon 

DOC – dissolved organic carbon 

ppt – parts per thousand  

 

Figure 0-13. Example of an input check report generated by the check inputs 
function 

5.6.6 Run BLM 

The “Run BLM” icon is used to launch the BLM calculation engine to predict either 
metal toxicity or speciation for the user-specified selections for the site water 
chemistry described in the BLM data file currently open in the BLM Windows® 
Interface. If the BLM data file has changed since the last time it was saved and the user 
tries to run the BLM, the user will be queried as to whether the current file should be 
saved prior to the BLM run. If the option to calculate the FMB is selected but the user 
does not have enough valid data in the input file, then a warning will display when 
this button is clicked (the model will still complete its run, just without the FMB 
calculation). 

5.7 CURRENT SELECTION DISPLAY 

This area of the interface window displays the current water type, metal, organism, 
and prediction mode selections made by the user. In the example shown in Figure 5-1, 
the user has opted to predict the toxicity of Cu for the EPA WQC calculation in fresh 
water. The options selected by the user are saved in the BLM data file and by the 
program when it closes. When the program is opened, it will default to the set of 
options selected when last closed. When a BLM input file is opened, the application 
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either switches to the selections made by the user when the input file was last saved, 
or it asks the user to select an input file. 

5.8 DATA FILE DESCRIPTION 

This area is provided for the user to insert comments describing the BLM data file; 
these comments will then be saved along with the water chemistry parameters input 
by the user. Although this function is not of critical importance to the use of the BLM, 
for record-keeping and possibly quality assurance/quality control (QA/QC) purposes, 
it is useful. 

5.9 ITEM DESCRIPTION 

Located at the very bottom of the interface window, this area is designed to display a 
brief description of the icon/image/area over which the cursor is currently positioned. 
In the example shown in Figure 5-1, the cursor is positioned over the “Data Inputs” 
area. Similar messages are displayed when the cursor is moved over other areas of the 
interface window. 

5.10 DESCRIPTION OF OUTPUT FILES 

The BLM creates two or three output files within the directory containing the BLM 
input file. The files have the same filename as the input file, with “.sim,” “.det,” or 
“.wqc” added before the file extension. For example, using the input file “test.blm” 
would create the following output files: “test.sim.txt,” “test.sim.csv,” or “test.sim.xls” 
(the simple version of the model output); “test.det.txt,” “test.det.csv,” or “test.det.xls” 
(the detailed version); and “test.wqc.xls” (the water quality report, created only when 
running the model for an EPA WQC or HC5). The format of the output files (i.e., text, 
csv, or Microsoft Excel®) is selected under the “Options” menu (see Section 0).  

The “.det,” or detailed, output file contains all the chemical species accounted for in 
the BLM. Because the detailed file can be quite large, the “.sim,” or simple, output 
contains the following selected output results that may be of interest: 

 Site and sample names 

 BLM mode chosen (Speciation, Toxicity, LC50, etc.) 

 pH 

 Dissolved metal concentration in mol/L (the predicted FAV for Cu) 

 Free metal concentration in mol/L 

 Concentration of metal and metal hydroxide bound to DOC in mol/L  

 Concentration of metal on the biotic ligand(s) in nmol/gwet 

 DOC in mg/L 
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  Percent humic acid 

 Other input water chemistry in units of mol/L 

The “.wqc” file contains a pared-down version of the results and is meant for those 
users interested in only the points relevant to compliance: 

 Calculated FMB value(s) at the top (when that option is enabled) 

 Site and sample labels 

 Calculated WQC or HC5 value(s) in µg/L 

 Measured metal concentration in µg/L  

 Calculated toxic units (metal divided by WQC) 

 Flags indicating censored metal concentrations 

5.11 FMB CALCULATION 

The user may have the option to calculate the FMB for WQC and HC5 parameter files. 
Follow these steps to run FMB calculations: 

1. Load or enter data and save an input file as normal. There must be at least 10 
observations in the input file for the FMB to be calculated. Note that censored 
metal data should be marked with a “<” or entered as a negative number, 
which will then be displayed with a “<.” 

2. Select a WQC or HC5 parameter file from the “Metal/Organism Selection” 
dialog (see Section 0). 

3. Under the “Options” menu, two options will now be enabled: “Calculate FMB” 
and “FMB Center Statistic.” 

a. Make sure that “Calculate FMB” is checked.  

b. If you would like to change the center statistic from the default, which is the 
geometric mean (geomean), select your option in the “FMB Center Statistic” 
menu.  

4. Under the “Inputs” menu, the “Set Exceedance Frequency” option will now be 
enabled. Select it to change the target exceedance frequency for the FMB 
calculation. The default is once in three years. 

5. Click the “Run” button. 

6. Open the “*.wqc.xls” output file. The calculated FMB(s) will be located above 
the table in rows 5 through 8. 
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5.11.1 Using user-created HC5 files 

The BLM software does not currently have user interface support for specifying that a 
user-defined file contains an HC5 that can be used to calculate an FMB. However, it is 
still possible to use a user-created file for this purpose, but it involves manually 
changing some of the installation files for the software. An advanced user may be able 
to make these changes without compromising the software integrity, but we suggest 
contacting us for support if you have an HC5 you would like to use for FMB 
calculations. We can send you a custom software update with the necessary changes in 
place.  

5.12 BATCH MODE 

The BLM’s batch mode dialog can be accessed from the “File” menu by clicking the 
“Run Batches...” menu item. The BLM software can only accept 1,000 site chemistry 
observations at a time (because of memory issues), but monitoring datasets often 
contain many times that number. Therefore, a way to import large amounts of data 
and save and/or run them in (up to) 1,000-observation batches is useful. A screenshot 
of the batch mode dialog is shown in Figure 0-14, and the components shown therein 
are explained below. 

 

Figure 0-14. The batch run utility dialog 
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5.12.1 File type 

In this section of the dialog, the user can choose between the two file types: 
“Spreadsheet with Data” or “Collection of Input Files.” The “Spreadsheet with Data” 
option allows the user to import data from a *.csv or *.xls file, have the program create 
BLM input files, and then optionally run the BLM with those files. The “Collection of 
Input Files” option allows the user to choose one or more BLM input files that have 
already been created and run each of them in sequence. The “Input Format,” 
“Component-Mapping Grid,” and “Batch Size” sections will disappear when the 
“Collection of Input Files” option is selected, since they are only relevant when 
importing data to create input files. 

5.12.2 Data file(s) 

The “Data File(s)” section has a box where the name of the single data file or the list of 
BLM input files that is/are selected will appear. Click the “Browse...” button next to 
this box to select which file(s) to use. Note that only one data file can be selected, but 
multiple BLM input files can be selected. A data file should have all relevant site 
chemistry data in columns (i.e., a column for temperature, a column for pH, etc.) and 
expressed as one of the accepted units used for that component (go to the “Inputs” 
menu and click “Set Units” to see these options). The columns should correspond to 
either full site chemistry components (temperature, pH, Cu, DOC, HA, Ca, Mg, Na, K, 
SO4, Cl, and alkalinity) or simple chemistry components (temperature, pH, Cu, DOC, 
and hardness) and should have unique names indicated in the first row. Accepted file 
types for data files are *.csv (comma-separated values) and *.xls (1997–2003 Microsoft® 
Excel). Note that the row limit for *.xls files is 65,536 rows, and larger datasets will require the 
use of a *.csv file. Conversely, the “Collection of Input Files” option allows the user to 
select any number and combination of full BLM chemistry and simple BLM chemistry 
files that it will then open and run in sequence. 

5.12.3 Input format 

This section only appears when the “Spreadsheet with Data” file type is selected. Here 
the user can select which set of chemical components to use (i.e., full or simple 
chemistry). If simple chemistry is selected, all of the input files that are created will use 
the ion ratios that are currently selected in the simple chemistry tab. The “Batch Run” 
dialog does not need to be closed to change the ion ratio selection. 

5.12.4 Component-mapping grid 

This section only appears when the “Spreadsheet with Data” file type is selected. 
When a data file is selected, the program will read the first row of the file for the 
column headers. These headers will appear as drop-down box options in the column 
labeled “Header” of the component-mapping grid. The program makes guesses 
wherever possible to fill in these options (e.g., if a column is called “DOC [mg/L],” the 
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program will fill in that header as the one to use for the DOC component). Check these 
assignments (the computer is only slightly smart) and fill in any that are missing by 
selecting an appropriate column header from the drop-down box that appears when \ 
a cell is selected for editing. Also make sure to check that the units are correct; they 
should match the units of the data in the data file. All of the components need to have 
a header assignment in order to run batch mode. The same header can be used more 
than once (e.g., if there is only one “ID” column, it can be used as both “Site Name” 
and “Sample Name”). 

5.12.5 Batch size 

This section only appears when the “Spreadsheet with Data” file type is selected. The 
“Batch Size” section of the dialog has a small text box and a slider for selecting the size 
of the batches into which the program should divide the data. It defaults to the 
maximum number of observations possible in one input file (1,000), but it can be 
adjusted if a smaller number of observations per file is desired. Move the slider or type 
a number in the box to change the batch size. If the number of observations is not a 
multiple of the batch size, then the last batch will be smaller than the batch size 
number. 

5.12.6 Output directory 

The “Output Directory” section is for choosing and/or displaying where the files are 
going to be saved. The “Spreadsheet with Data” option lets the user choose a different 
directory for saving the newly created BLM input files and their associated output 
files, or keep the default directory (the same directory the data file is in). Clicking the 
“Browse...” button opens a separate dialog that the user can use to navigate to an 
existing directory. A new directory can be created by modifying the “Directory Name” 
field of the selection dialog. When the “Collection of Input Files” option is selected, the 
output directory cannot be changed; it is being displayed for clarity only and will be 
the same directory from which the input files come. 

5.12.7 Execute 

The “Execute” button tells the program to perform the action displayed in the 
drop-down box next to the “Execute” button. The “Create input files only” option is 
available only when the “Spreadsheet with Data” file type option is selected. With this 
option selected, the program will not normalize any of the data; it will just make the 
input files and stop. If a “Run...” option is selected instead, then the program will do 
the equivalent of reading an input file and clicking the “Run” button in the main 
interface. When all batches are finished running, a message will appear that tells the 
user when it finished and how long it took. It takes about one hour to run one 
250-observation batch, but the exact amount of time depends on computing power 
and how difficult the chemistry is for the BLM engine to converge on. Be patient and 
remember that the BLM engine is doing around 80 chemical equilibria calculations 
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consisting of more than 100 chemical reactions and more than 25 mass balances, and 
solving a non-linear optimization algorithm for each site chemistry observation. 
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6 Example Application 

The BLM Windows® Interface installation also features an example application for 
demonstration purposes. This file, named “LakeSuperior.blm,” is installed along with 
the application and is located in the BLM data directory asked for during installation 
(by default within the “My Documents” folder). The file can be opened directly, by 
double-clicking on the file name through a file system manager such as Microsoft 
Windows® Explorer, or by first starting the BLM Windows® Interface application and 
selecting the file through the “File -----> Open” action. This example data file contains 
the 2009 average water quality observations from Lake Superior, as reported by Tetra 
Tech (2013).  

The data file “LakeSuperior.blm” can be used to predict metal speciation using the 
input metal concentration, or to predict the LC50 for a variety of metals and 
organisms. It is recommended that separate BLM data files always be maintained for 
each metal. In this case, the data file contains dissolved Cu concentrations; the BLM 
can be used to predict the inorganic, organic, and biotic speciations by setting the BLM 
prediction mode to “Speciation” using the shortcut Menu button “Prediction Mode.” 
Metal toxicity for the specified site water chemistry can also be predicted by setting 
the prediction mode to “Toxicity” and selecting the metal and organism for which 
toxicity is to be predicted using the shortcut Menu button “Metal/Organism 
Selection.” 

Once the user has defined the scope of the BLM predictions, the BLM can be run using 
the shortcut Menu button “Run BLM.” Depending on the number of lines of inputs in 
the BLM data file, the runtime for the BLM predictions can vary from a few seconds to 
several minutes. Upon completion of the BLM run, the user is informed of the names 
and locations of the output files and given the option to open the directory, as shown 
in Figure 0-1. The contents of the output files are described in Section 5.10. 

 

Figure 0-1. Example of notification window shown at completion of BLM run 
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7 Uninstalling the BLM 

To uninstall the BLM Windows® Interface, select the uninstall utility using “Start -----> 
Programs -----> Biotic Ligand Model -----> Uninstall….” All files installed by the BLM 
during setup will be uninstalled. However, none of the files created by the user and 
saved in the BLM installation directory will be deleted during the uninstall. These files 
will have to be deleted manually by the user, if so desired.  
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8 Ion Ratio Tables 

Monitoring data were gathered from across the United States and Canada (Table 8-1). 
Data from the United States were collected using the dataRetrieval package in R 
statistical software, totaling 21,685 observations from 47 states (Hirsch and De Cicco, 
2015) (Table 8-2). The Canadian data were mostly collected from publicly available 
monitoring data, totaling 40,498 observations from 13 provinces and territories 
(Table 8-3). 

Table 8-1. Median ion ratios in North America 

Geographic Unit Ca:Mg Ca:Na Ca:K SO4:Cl 

North America 2.04 1.33 12.61 0.79 

Canada 2.14 1.47 13.94 1.70 

United States 2.11 1.19 12.21 0.65 

Table 8-2. Median ion ratios in Canadian provinces 

Geographic Unit Ca:Mg Ca:Na Ca:K SO4:Cl 

Alberta 1.82 1.96 29.27 4.70 

British Columbia 3.33 3.30 23.51 3.86 

Manitoba 1.28 1.29 8.69 1.52 

New Brunswick 4.15 1.35 16.92 0.48 

Newfoundland and Labrador 2.49 0.42 6.79 0.10 

Northwest Territories 1.87 2.15 7.32 1.23 

Nova Scotia 1.28 0.15 3.49 0.12 

Nunavut 2.61 3.58 6.66 4.92 

Ontario 2.27 1.34 13.19 1.41 

Prince Edward Island 1.53 2.51 31.86 0.16 

Quebec 2.48 1.41 16.26 0.56 

Saskatchewan 0.83 0.48 4.61 3.29 

Yukon 3.35 8.07 37.53 22.14 

Table 8-3. Median ion ratios in US states 

Geographic Unit Ca:Mg Ca:Na Ca:K SO4:Cl 

Alabama 2.81 0.89 8.26 0.81 

Alaska 2.87 5.26 25.22 5.87 

Arizona 1.76 0.54 18.93 0.95 

Arkansas 2.84 0.79 11.38 0.29 

California 2.20 0.54 9.73 0.41 
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Geographic Unit Ca:Mg Ca:Na Ca:K SO4:Cl 

Colorado 2.81 1.23 12.68 1.81 

Connecticut 2.05 0.47 8.13 0.08 

Delaware 1.70 0.67 6.26 0.19 

Florida 4.83 1.68 5.75 0.48 

Georgia 2.39 0.57 3.17 0.35 

Hawaii 0.86 0.38 5.35 0.08 

Idaho 1.67 1.04 11.56 0.76 

Illinois 1.73 1.80 13.68 0.75 

Indiana 1.99 1.95 16.93 0.64 

Iowa 1.56 2.60 17.31 0.53 

Kansas 3.04 0.71 9.11 0.36 

Kentucky 3.40 2.59 11.55 0.58 

Louisiana 1.97 1.13 10.85 0.63 

Maryland 2.31 1.19 11.59 0.47 

Massachusetts 3.70 0.23 6.22 0.07 

Michigan 2.11 0.90 21.53 0.10 

Minnesota 0.89 1.31 18.91 0.73 

Mississippi 1.89 1.34 6.60 0.74 

Missouri 1.76 1.19 10.65 1.62 

Montana 2.01 1.02 13.58 5.09 

Nebraska 1.88 0.75 10.04 2.23 

Nevada 1.65 0.46 15.07 1.01 

New Hampshire 2.39 0.12 5.39 0.05 

New Jersey 1.76 0.60 10.64 0.21 

New Mexico 3.64 1.19 12.76 2.51 

New York 2.86 1.42 20.94 0.47 

North Carolina 1.62 0.57 1.84 0.24 

North Dakota 1.49 0.54 12.09 5.68 

Ohio 2.02 1.52 11.41 0.51 

Oklahoma 1.86 0.53 7.68 0.34 

Oregon 1.90 1.32 11.45 0.38 

Pennsylvania 2.10 1.48 13.61 0.53 

South Carolina 1.38 0.45 2.12 0.23 

South Dakota 1.55 0.48 10.90 7.59 

Tennessee 2.18 2.06 11.08 1.04 

Texas 2.67 0.46 14.99 0.49 

Utah 1.46 0.51 19.04 1.12 
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Geographic Unit Ca:Mg Ca:Na Ca:K SO4:Cl 

Virginia 1.39 0.70 4.13 0.18 

Washington 1.83 1.06 10.09 1.28 

West Virginia 1.12 1.20 11.46 4.29 

Wisconsin 1.34 0.89 20.05 0.21 

Wyoming 2.12 0.62 14.15 2.35 
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